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 MEETINGS are held 

on the third 

Wednesday of the 

Month, in the  Hall at 

the rear of  

St Mary’s Catholic 

Church 

Morphett Vale. 

(Corner Bains Road 

and Main South 

Road) 

Visitors most 

welcome.  
Cost $2 per person, 
which includes the 

Newsletter, plus 
coffee/tea and biscuits. 

Subscriptions for 
twelve months Single 

$18 
Family membership 

$24 
Novice and 

experienced computer 
users will be warmly 

welcomed  
 

After three visits in a 

twelve month period  

visitors are required to 

become members. 

       SOUTHERN DISTRICTS COMPUTER 

USERS CLUB INC.  

 APRIL  2012 
Club Web Site    http://sdcuci.com/ 

Editor Jim Greenfield 

TOPIC FOR MAY MEETING 

Lionel Leddra a presentation  on the joys of Microsoft 

Works program.  

A Microsoft program that compares favorably with Office 

2010, but at a fraction of the cost. 

APRIL 25th 

They shall grow not old, as 
we that are left grow old: 

Age shall not weary them, 
nor the years condemn. 

At the going down of the sun 
and in the morning, 

We will remember them 

APRIL  25th 

They shall grow not old, as we that 

are left grow old: 

Age shall not weary them, nor the 

years condemn. 

At the going down of the sun and in 

the morning, 

We will remember them 
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Automotive Repairs 

 
ALL GENERAL  

MECHANICAL REPAIRS 
Brakes, Suspension, Clutch, 

Auto Trans Service, 
Wheel Balance & Repairs, 

New & S/Hand Tyres. 
SERVICE, TUNE & SAFETY CHECK 
(most 4 & 6 cyl. cars) - Includes plugs, 

points, oil, filter. 
 

U4/2 Somerset Circuit 
Lonsdale S.A. 5160 

� 8186 0081 

Pensioner 

& Seniors 

Discount 

Have you recently acquired, 
or do you just want to learn 
more about  operating your 

computer? 

The Club conducts classes on a wide 
range of subjects, at a very moderate 
charge. 

The maximum number in class is five.  

(Our aim is to conduct the classes in a 
friendly non-threatening atmosphere). 

Some of the classes that are available:- 

1. Basic Computing (Stage One and / 
or Stage Two). 

2. Advanced Word. 

3. Internet workshops. 

4. Digital Cameras. 

For more information 
contact a committee 

member. 

 

 

 

BY-PASS THE RECYCLE BIN 

When you delete files the files first go to the 

Recycle Bin so that they may be recovered.  

When deleting a large amount of files, this 

process may not be desirable because of the 

amount of time it takes to move them to the 

Recycle Bin and then empty the Recycle Bin, 

essentially deleting them twice. There is an easy 

way to bypass the Recycle Bin altogether.  
 

When deleting a folder or group of files:  

Select the folder or group of files to be 

deleted.  

Hold down the SHIFT key while pressing 

the DELETE key.  

NOTE: Be aware that after files are deleted in 

this manner, they cannot be undeleted or 

recovered.  
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Word 2010  and  Publisher 2010 

Insert a symbol  
Click where you want to insert the symbol. 
On the Insert tab, click Symbol, and select the symbol you want or 
click More Symbols. 
In the Font box, click the font that you want. 
If you are inserting Unicode characters and you are using a font such as Arial or 
Times New Roman that contains subcategories, the Subset list is displayed. Click the 
character subset, such as Basic Latin or LetterClick Close. 

 NOTE   The symbols shown when you click the Symbol button will be updated with 
your most recently used symbols, allowing you to quickly find and insert symbols 
you use regularly. 

Examples of a few of many available symbols. 
 
 �  @  �  �  �  �  £ 

 �  �  �  �  Ω  �  † 

 ♀  ♂  ē  ă  ₡   �  �   

 �  �  �  �  α  β  Ωε 

Her First CakeHer First CakeHer First CakeHer First Cake    
She measured out the butter with a very serious air, 
The milk and sugar also, and she took the greatest care 
To count the eggs correctly, and to add the little bit 

of baking powder, which, you know beginners oft omit. 
She mixed it all together, and she baked it full an hour, 
But he never quite forgave her for leaving out the flour. 
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 MEETING RULES 

 
We are allowed to use the facilities at Hall at the rear of St Mary’s Catholic Church Morphett Vale. (Corner Bains Road 
and Main South Road) in return of a small fee plus respect for their property. We ask for your co-operation in respect to 
the above. While we can not control what our members do away from our club meetings, Piracy of copyright material can 
not be condoned at our meetings. 

Things you see when on the road. 

Trevor FrancisTrevor FrancisTrevor FrancisTrevor Francis    
Travelling along Lonsdale Highway has its moments. A 
little earlier this month I was travelling south, past the 
Hallett Cove Shopping Centre when there in front of me 

was a strange sight. 
There was this green 4-wheel drive pulling along a trailer -  a 6 x 4 trail-
er. Nothing too unusual there except that the load was stacks of timber  
piled high upon each other -  layers and layers of them and all overhang-
ing the front, back and sides of the trailer. Looked pretty precarious.  
I was wondering what to do about this . .  should I call the police on the 
mobile and let them know of how some rednecks travel. Should I just 
follow at a reasonable distance to stop “tailgaters” – I did not like the 
thought of this load tumbling off into some pore sod that was following 
a bit too close behind. – or should I just give him a loud “toot” 
and the one finger salute on passing.  
 
Good sense prevailed and as I was passing I prepared to give 
whoever it was the “salute”   This never eventuated because as I 
drew level I saw the passenger was a face I recognised. -  and the driver 
even more so . .  it was our illustrious computer “guru” with a couple of 
likely lads who I later discovered were transporting a cubby house (that 
they had pick up for nothing) back to Morphett Vale for the grandkids.  
What guys!  The cubby is now “up” and fit for royal children.  

 Go Granddad! 
Note from the editor:-Thank you to Colin and Allan for helping our president to carry out 

this difficult manoeuvre. 

If the temperature is zero outside today and it's If the temperature is zero outside today and it's If the temperature is zero outside today and it's If the temperature is zero outside today and it's 
going to be twice as cold tomorrow, how cold will it going to be twice as cold tomorrow, how cold will it going to be twice as cold tomorrow, how cold will it going to be twice as cold tomorrow, how cold will it 
be?be?be?be?    
    
If electricity comes from electrons, does morality If electricity comes from electrons, does morality If electricity comes from electrons, does morality If electricity comes from electrons, does morality 
come from morons?come from morons?come from morons?come from morons?        
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 Southern Districts Computer Users Club Inc. 

For further information about S.D.C.U.C.Inc. 
 

Contact The Club President,  
Jim Greenfield 83824912 

Or 
The Secretary 

Correspondence to 
The Secretary 
S.D.C.U.C.I. 

Box 991 
Morphett Vale  5162 

 
Email to 

secretary@sdcuci.com 

 
Wife by text to husband at work ............ 

"Windows at home frozen - what should I do?" 
Husband - "spray some de-icer or pour hot water on them" 
Wife a few minutes later - "Done that - now computer won't work at all"! 

  

If quizzes are quizzical, what are tests? 
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Line spacing in Word 2010 

Adjust the spaces between lines or paragraphs 

Line spacing determines the amount of vertical space between the lines of text in a paragraph. 

Paragraph spacing determines the amount of space above or below a paragraph. 
 

In Microsoft Word 2010, the default spacing for most Quick Style sets is 1.15 between lines 

and a blank line between paragraphs. The default spacing in Office Word 2003 documents is 

1.0 between lines and no blank line between paragraphs. 

Change the line spacing 

The easiest way to change the line spacing for an entire document is to apply a Quick Style set 

that uses the spacing that you want. If you want to change the line spacing for a portion of the 

document, you can select the paragraphs and change their line spacing settings. 

USE A STYLE SET TO CHANGE LINE SPACING FOR AN ENTIRE DOCUMENT 

1. On the Home tab, in the Styles group, click Change Styles.  

2. Point to Style Set, and point to the various style sets. Using the live preview, notice 

how the line spacing changes from one style set to the next.  

For example, the Traditional and Word 2003 style sets use single-spacing. The Manuscript 

style set uses double spacing. 

3. When you see spacing that you like, click the name of the style set. 

CHANGE THE LINE SPACING IN A PORTION OF THE DOCUMENT 

1. Select the paragraphs for which you want to change the line spacing. 

2. On the Home tab, in the Paragraph group, click Line Spacing.  

3. Do one of the following:  

	 Click the number of line spaces that you want.  

For example, click 1.0 to single-space with the spacing that is used in earlier versions of 

Word. Click 2.0, to double-space the selected paragraph. Click 1.15 to single-space with 

the spacing that is used in Word 2007. 

	 Click Line Spacing Options, and then select the options that you want under 

Spacing. See the following list of available options for more information.  

LINE SPACING OPTIONS 

Single  This option accommodates the largest font (font: A graphic design applied to all 

numerals, symbols, and alphabetic characters. Also called type or typeface. Arial and Courier 

New are examples of fonts. Fonts usually come in different sizes, such as 10 point, and various 

styles, such as bold.) in that line, plus a small amount of extra space. The amount of extra space 

varies depending on the font that is used.  

1.5 lines this option is one-and-one-half times that of single line spacing.  

Double This option is twice that of single line spacing.  

At least This option sets the minimum line spacing that is needed to fit the largest font or 

graphic on the line.  
Continued on page 7 
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Exactly  This option sets fixed line spacing, expressed in points. For example, if the text is in a 

10-point font, you can specify 12 points as the line spacing.  

Multiple This option sets line spacing that can be expressed in numbers greater than 1. For 

example, setting line spacing to 1.15 will increase the space by 15 precent, and setting line 

spacing to 3 increases the space by 300 precent (triple spacing).  

 NOTE    If a line contains a large text character, graphic, or formula, Word increases the 

spacing for that line. To space all lines evenly within a paragraph, use exact spacing and specify 

an amount of space that is large enough to fit the largest character or graphic in the line. If items 

appear cut off, increase the amount of spacing. 

Change the spacing before or after paragraphs 

The easiest way to change the spacing between paragraphs for an entire document is to apply a 

Quick Style set that uses the spacing that you want. If you want to change the spacing between 

paragraphs for a portion of the document, you can select the paragraphs and change their 

spacing-before and spacing-after settings. 

USE A STYLE SET TO CHANGE PARAGRAPH SPACING FOR AN ENTIRE DOCUMENT 

1. On the Home tab, in the Styles group, click Change Styles..  

2. Point to Style Set, and point to the various style sets. Using the live preview, notice 

how the line spacing changes from one style set to the next.  

For example, the Word 2003 style set inserts no extra space between paragraphs and a small 

amount of space above headings. The Word 2007 style set uses a double space between 

paragraphs and adds more space above headings. 

3. When you see spacing that you like, click the name of the style set. 

CHANGE THE SPACING BEFORE AND AFTER SELECTED PARAGRAPHS 

By default, paragraphs are followed by a blank line, and headings have extra space above them. 

1. Select the paragraph before or after which you want to change the spacing.  

2. On the Page Layout tab, in the Paragraph group, under Spacing, click the arrow next 

to Before or After and enter the amount of space that you want.  

Use Word 2003 spacing 

The quickest way to apply Word 2003-style spacing to your document is to apply the Word 

2003 style set. 

1. On the Home tab, in the Styles group, click Change Styles..  

2. Point to Style Set, and click Word 2003. 

Set the default to single-spacing for all new documents 

1. On the Home tab, in the Styles group, click Change Styles..  

2. Point to Style Set, and click Word 2003.  

3. In the Styles group, click Change Styles, and then click Set as Default. 

 NOTE    If you try using another style set in your document and you want to return to your 

custom default setting, click Change Styles in the Styles group, point to Style  
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Jack Tramiel, a Pioneer in Computers, Dies at 83 

 

 

 

 

 

Jack Tramiel, a hard-charging, cigar-chomping tycoon whose inexpensive, immensely popular 

Commodore computers helped ignite the personal computer industry the way Henry Ford’s 

Model T kick-started the mass production of automobiles, died on Sunday 8th May 2012in 

Palo Alto, California. He was 83.  

Commodore rose to prominence in the 1970s and ’80s, producing the first computer to sell a 

million units. Another model, the Commodore 64, sold more than 20 million units — four 

times the sales of the Apple II, which is often said to have established the personal computer 

market. Sales of the 64 exceeded $1 billion.  

Mr. Tramiel’s business model was ruthlessly efficient: he introduced a new product at the 

lowest price possible, and as the competition matched his price he went even lower. He did this 

by slashing costs, hiring top engineering talent, selling in mass-market stores like Kmart, and 

owning the suppliers of chips and other components. He changed directions in an instant, 

going so far as to introduce a new product even if it hurt sales of an existing one. He liked to 

say that business is war.  

Mr. Tramiel’s boldness was suggested by a full-page newspaper advertisement he ran in 1983 

when Commodore was flying highest: “Commodore Ate the Apple.”  

In fact, Mr. Tramiel (pronounced truh-MEEL) had so little use for Apple’s emphasis on design 

elegance and technical sophistication that Time magazine called him the “anti-Steve Jobs.” Mr. 

Tramiel wanted affordable, easy-to-use computers in every home; he spoke of serving 

“masses, not classes.”  

He was born Jacek Trzmiel in Lodz, Poland, on Dec. 13, 1928. After the Germans invaded on 

Sept. 1, 1939, his family was confined to Lodz’s Jewish ghetto, where they lived in a single 

room while his father scratched out a living repairing shoes. In August 1944, the Nazis 

deported the family to the Auschwitz death camp, where Dr. Josef Mengele, the SS officer 

notorious for conducting heinous experiments on inmates, selected Jacek and his father for 

work detail at a nearby camp.  

 

His mother remained behind in Auschwitz and survived; his father did not. Mr. Tramiel was 
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told that his father had died of typhus but believed that he had actually been injected with 

gasoline.  

After being liberated by American troops, Mr. Tramiel scrounged around Europe for two years, 

picking up odd jobs. He had himself admitted to a psychiatric sanitarium just so he could eat.  

In 1947 he married Helen Goldgrub, whom he had met in a concentration camp, then left for 

the United States, where his wife joined him in 1948 and his mother in 1949. Joining the Army, 

he learned to repair typewriters. After his discharge, he drove a cab, used a G.I. loan of $25,000 

to buy a typewriter store in the Bronx, and changed the spelling of his surname.  

In the 1950s he moved his business to Toronto, where he had family and where the laws made 

it easier to import typewriters from Europe. By then his business had grown into an office-

machine company. He chose the name Commodore, he said, after glancing at an Opel 

Commodore while riding in a cab.  

In the 1960s, Mr. Tramiel became the subject of a widely publicized insider-trading 

investigation involving loans to his company. Though he was not indicted, the publicity made it 

difficult for him to continue to do business in Canada, so he moved the company to the 

emerging Silicon Valley area of California in the late 1960s.  

A trip to Japan introduced him to digital calculators, and he began to manufacture them. The 

competition to cut prices in the calculator business was unrelenting, so he scrambled for ways 

to cut costs. He decided to buy his own chip supplier, and settled on MOS Technology in 

Norristown, Pa. An unexpected jewel in the purchase was an MOS engineer, Charles Peddle, 

who had developed a faster, cheaper computer chip, the 6502 microprocessor.  
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Kirby Vacuum Cleaner Generation 3 
Excellent condition 
Carpet shampoo attachments 
Manny cleaning nozzles and storage bracket 
Instruction  manual etc. 
See Lorraine or  Ian � � � � 83827243 
 
 
Camping Chairs  
Recliner  padded type 
Good condition  
$15 Each Phone  Ian or Lorraine 
� � � � 83827243 

10 of the finest (unintentional) double-entendres ever aired on 

British TV and radio: 
1. Ted Walsh - Horse Racing Commentator - 'This is really a lovely horse. I once rode her 
mother. 
2. New Zealand Rugby Commentator - 'Andrew Mehrtens loves it when Daryl Gibson comes 
inside of him.' 
3. Pat Glenn, weightlifting commentator - 'And this is Gregoriava from Bulgaria . I saw her 
snatch this morning and it was amazing! 
4. Harry Carpenter at the Oxford-Cambridge boat race 1977 - 'Ah, isn't that nice. The wife of 
the Cambridge President is kissing the Cox of the Oxford crew.' 
5. US PGA Commentator - 'One of the reasons Arnie (Arnold Palmer) is playing so well is that, 
before each tee shot, his wife takes out his balls and kisses them. Oh my god !! What have I just 
said? 
6. A female news anchor who, the day after it was supposed to have snowed and didn't, turned 
to the weatherman and asked, 'So Bob, where's that eight inches you promised me last night?' 
Not only did HE have to leave the set, but half the crew did too, because they were laughing so 
hard! 
7. Clair Frisby talking about a jumbo hot dog on 'Look North' said: 'There's nothing like a big 
hot sausage inside you on a cold night like this. ' 
8 Mike Hallett discussing missed snooker shots on 'Sky Sports': 'Stephen Hendry jumps on 
Steve Davis's misses every chance he gets.'  
9. Michael Buerk on watching Philippa Forrester cuddle up to a male astronomer for warmth 
during BBC1's UK eclipse coverage remarked: 'They seem cold out there. They're rubbing each 
other and he's only come in his shorts.'  
10. Ken Brown commentating on golfer Nick Faldo and his caddie Fanny Sunneson lining-up 
shots at the Scottish Open: 'Some weeks Nick likes to use Fanny; other weeks he prefers to do it 
by himself.' 
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PARAPROSDOKIANS  
I had to look up "paraprosdokian".  
Here is the definition: "Figure of speech in which the latter part of a sentence or 
phrase is surprising or unexpected; frequently used in a humorous situation."   
"Where there's a will, I want to be in it," is a type of paraprosdokian. 
 

Ok, so now enjoy! 
• Do not argue with an idiot. He will drag you down to his level and beat you 

with experience. 

• The last thing I want to do is hurt you. But it's still on my list 

• Light travels faster than sound. This is why some people appear bright until 
you hear them speak. 

• If I agreed with you, we'd both be wrong. 

• We never really grow up, we only learn how to act in public. 

• War does not determine who is right - only who is left 

• Knowledge is knowing a tomato is a fruit. Wisdom is not putting it in a fruit 
salad. 

• Evening news is where they begin with 'Good Evening,' and then proceed to 
tell you why it isn't 

• To steal ideas from one person is plagiarism. To steal from many is research. 

• A bus station is where a bus stops. A train station is where a train stops. On 
my desk, I have a work station. 

• thought I wanted a career. Turns out I just wanted paychecks. 

• Whenever I fill out an application, in the part that says, 'In case of 
emergency, notify:' I put 'DOCTOR. 

• I didn't say it was your fault, I said I was blaming you. 

• Women will never be equal to men until they can walk down the street with a 
bald head and a beer gut, and still think they are sexy 

• Behind every successful man is his woman. Behind the fall of a successful 
man is usually another woman. 

• A clear conscience is the sign of a fuzzy memory. 

• I asked God for a bike, but I know God doesn't work that way. So I stole a 
bike and asked for forgiveness. 

• You do not need a parachute to skydive. You only need a parachute to 
skydive twice. 

• Money can't buy happiness, but it sure makes misery easier to live with 

• There's a fine line between cuddling and holding someone down so they 
can't get away. 

• I used to be indecisive. Now I'm not so sure. 

• You're never too old to learn something stupid. 

• To be sure of hitting the target, shoot first and call whatever you hit the 
target. 

• Nostalgia isn't what it used to be. 

• Change is inevitable, except from a vending machine. 

• Going to church doesn't make you a Christian any more than standing in a 
garage makes you a car. 
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